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1) Analysis Systems 

Quintic allows the user to analyse the digitised movement. These values are 

automatically calculated for you and can be viewed in graphical form by pressing either 

the Linear Analysis   or the Angular Analysis   buttons.  

From this you can then select Single Video Analysis or Multi Video Analysis.  

Linear Analysis    

Click on the Linear Analysis button, then either select ‘Single Video Linear Analysis’ or 

‘Multi Video Linear Analysis’ (this is covered in Tutorial 8C).  

 

 

 

Linear analysis will provide data on the Distance, Velocity and Acceleration of the points 

that have digitised.  

Angular Analysis 

Click on the Angular Analysis button, then either select ‘Single Video Angular Analysis’ or 

‘Multi Video Angular Analysis’ (this is covered in Tutorial 8C).  

 

 

 

 

Angular Analysis will provide data on Angular Displacement, Angular Velocity and Angular 

Acceleration of the points that have been digitised.  

 

 



 

 

2) Single Video Linear Analysis 

Once the video has been digitised and the trace has been loaded, simply click on the 

‘Single Video Linear Analysis’ option after the Linear Analysis button has been pressed.  

If the digitisation trace has not been loaded on the video, the following pop up will appear, 

asking you to load the digitisation trace. Please click ‘Yes’.  

 

 

 

 

 

Once the digitisation trace is loaded and the ‘Single Video Linear Analysis’ button has 

been pressed, the Single Video Linear analysis window will load.  

This will display the Distance, Velocity and Acceleration in 3 different graphs, for the points 

that have been digitised throughout the video.  

If there are any Time Event Markers (please see Tutorial 2 for further information) that 

have been saved with the current video, they will also be displayed onto all 3 graphs. This 

will allow the user to quickly identify on the graph the key events of interest to them (e.g. 

Impact, Low Point, Toe Off etc). The Time Event Markers will be displayed on the graphs 

by a blue line, with the default name of Marker 1, Marker 2, if the Time Event Markers have 

not been named, or the relevant name of that marker if they have been named.  

Any Interpolation Markers that have been added to the digitisation trace and saved, will 

also be shown on the graphs. These are shown with a burgundy line on the graphs.  

Please see below an example of the Single Video Analysis Window within Quintic 

Biomechanics v35 software.  

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Digitisation Trace 

Information. Please see 

below for further 

information 

 

Select which digitised 

markers you want to 

display on the graph by 

ticking/unticking the 

relevant boxes. 

 
Select linear, horizontal or 

vertical values by ticking 

the relevant box. These 

values will then also be 

displayed on the 

corresponding graphs. 

Users are also able to 

‘opposite’ the horizontal 

direction of the trace. 

 

Data Series Type – Either 

smoothed or raw data. In 

this example smoothing 

parameters have been 

applied to the trace.  

Time – This displays 

the current time of the 

associated video.  

Frame Number 

– This displays 

the current frame 

number of the 

associated video.  

Moving Average – This displays 

the moving average that is 

applied to the data. Please see 

the heading ‘Moving Average’  

below for more information.   

Frame Range – This displays 

the digitisation range for the 

associated video. The 

digitisation trace starts on the 

first number and ends on the 

second number.  

Record Speed – Calibrated 

frames per second of the 

associated video.   



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Point Names and relevant digitisation trace 

information are coloured red when the 

associated video is outside of the 

digitisation range in the associated Quintic 

playback window.  

 

Point Names and relevant digitisation trace 

information are coloured black when the 

associated video is within the digitisation range 

in the associated Quintic playback window.  

 

Live Data Table – This button 

will pop open the Live Data 

table, which allows the user 

to easily identify data values 

at specific points of interest, 

throughout the video. Please 

see the heading ‘Live Data 

Table’ below for more 

information.  

 

Select All – When pressed, 

this will show all of the 

digitised points on the 

associated graphs.  

 

Deselect All – When 

pressed, this will hide all of 

the digitised points on the 

associated graphs.  

 



 

 

Both the video and analysis windows are synchronised, therefore if the video is played / 

scrolled while the separate analysis window is open, a black line indicates the current video 

frame. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

a. Functions 

Within the Single Video Linear Analysis window there are a range of options which the user 

is able to select, which directly effects the distance, velocity and acceleration graphs.  

The functions are available at the top of the Single Video Linear Analysis Window and are 

as follows: 

 

b. File  

Within the File menu, the user is able to Print, Print Preview, Save as JPEG or Copy to 

Clipboard for the individual Distance, Velocity and Acceleration graphs. The user is also 

able to Print, Save as JPEG or Copy to Clipboard the Distance, Velocity and Acceleration 

Graphs with or without the side bar as one image.   

 

 

 

 

c. Units 

Within the Units menu, the user can change the units for the Distance and 

Speed/Acceleration graphs. The Distance options are Metres or Feet. The 

Speed/Acceleration options are as follows: Metres/Second, Kilometres per hour, 

Feet/Second or Miles per hour.  

 

 

 

 



 

 

d. Frames/Page 

Within the Frames/Page menu, the user is able to select how many frames are displayed 

on the graphs within the analysis window. This is ideal for users who have long digitisation 

traces. 

 

 

 

 

 

As default, the analysis windows will display all of the points on the graphs. Should users 

want to change this, they are able to do this by going to the Help tab within the main 

Quintic software. To do this, click the ‘Help’ button, then Settings, Analysis Defaults, 

Frames/Page and then select your preferred option. This will apply to all analysis windows. 

 

 

 

 

 

 

 

  

 

 

 



 

 

e. Display 

Within the Display menu, the user is able to able to adjust certain display settings which 

affect the Distance, Velocity and Acceleration graphs.  

 

 

 

 

 

 

 

 

 

Show Frame Position – Ticking and Unticking the Show Frame Position (Default – 

Ticked/On) will show or hide the black line which shows the current frame position in 

relation to the current frame position in the associated Quintic window. 

Show Frame Position ON: 

 



 

 

Show Interpolation Markers – Ticking and Unticking the Show Interpolation Markers 

(Default – Ticked/On) will show or hide any Interpolation markers which are saved with the 

associated digitisation trace. They will be shown on the graph by a burgundy line(s).  

Show Interpolation Markers ON: 

 

Show Frame Markers – Ticking and Unticking the Show Frame Markers (Default – 

Ticked/On) will show or hide any frame (Key Event) markers if there are any saved and 

within the digitisation range. They will be shown on the graph by blue line(s) and will either 

say Marker 1, Marker 2 etc if they have not been named or the relevant names if they have 

been named.  

Show Frame Markers ON: 



 

 

Show Interpolated Regions (Intelligent) – Ticking and Unticking the Show Interpolated 

Regions (Intelligent) will show or hide any regions where the reflective markers were lost or 

occluded and the marker(s) were interpolated. When analysing trial data in Quintic, the 

regions where interpolation has occurred are shown using different colours of box and 

hatching: 

Solid Grey Box – This occurs when the whole reference template has been lost from the 

Area of Interest (AOI). The solid grey box appears on the graph between the frame where 

the template was completely lost and the frame where the whole template was re-found. 

The data series in this region is obscured from view. 

 

Coloured Hatching – Covers the region of the graph where a single marker has been lost. 

The colour of the box is dependent on the colour of the marker selected when creating the 

reference model.  

Interpolated Regions ON:  

When using Single Angular Analysis hatching will only be displayed when the selected 

angle includes the marker that has been interpolated. E.g. When analysing the knee 

angular velocity during a gait analysis, regions where the hip marker has been interpolated, 

the hatchings will be displayed.However, in order to show interpolated regions, all videos 

must be digitised using the Intelligent Digitisation function in Quintic Coaching or 

Biomechanics v29/v31/v33/v35. 



 

 

Minimums – The user is able to identify the minimum point on the Distance, Velocity and 

Acceleration graphs. Options are: 

• Min 

• Min and Value 

• Min, X Pos and Value.  

Min – This will draw a small notch for each individual trace at the minimum position of the 

graph for distance, velocity and acceleration.  

 

 

 

 

Min and Value – This will draw a small notch and give the minimum value at the minimum 

position of the graph for distance, velocity and acceleration.  

 

 

 

 

Min, X Pos and Value – This will draw a small notch, the X position (whether this be time or 

frame number) and the minimum value at the minimum position of the graph for distance, 

velocity and acceleration.  

 

 

 

 



 

 

Maximums – The user is able to identify the maximum point on the Distance, Velocity and 

Acceleration graphs. Options are: 

• Max 

• Max and Value 

• Max, X Pos and Value.  

Max – This will draw a small notch for each individual trace at the maximum position of the 

graph for distance, velocity and acceleration.  

 

 

 

 

Max and Value – This will draw a small notch and give the maximum value at the maximum 

position of the graph for distance, velocity and acceleration.  

 

 

 

 

Max, X Pos and Value – This will draw a small notch, the X position (whether this be time 

or frame number) and the maximum value at the maximum position of the graph for 

distance, velocity and acceleration.  

 

 

 

 



 

 

Horizontal Axes – This allows the user to edit the horizontal axes on the Distance, 

Velocity and Acceleration graphs. The options available to the user are: Frame Number, 

Time, Relative Frame Number, Relative Time, Relative Frame Number (Marker) and 

Relative Time (Marker).  

 

 

 

Frame Number – The horizontal axis will be the relevant frame numbers from the 

associated video. As both the associated video and the Single Linear Analysis Window are 

synchronised, the frame numbers of the video will match the frame numbers on the graphs 

e.g frame number 796 in the video will also be frame number 796 on the graphs.  

Time – The horizontal axis will be the relevant time from the associated video. This is time 

from the start of the video, not the digitisation trace. For example, if your digitisation trace 

starts at 1.2 seconds into the video, 1.2 seconds will be where the horizontal axis will start 

from.  

Relative Frame Number – The horizontal axis will start from 0, with 0 being the start of the 

digitisation trace as it is relative to the first digitised frame. For example, if your digitisation 

trace starts at frame number 614 on the video, this will appear as 0 on the graphs. 

Relative Time – The horizontal axis will start from 0, with 0 being the start of the digitisation 

trace as it is relative to the first digitised frame. For example, if your digitisation trace starts 

at 0.8 seconds into the video, this will appear as 0 on the graphs. 

Relative Frame Number (Marker) – This allows the user to change the 0 point of the x axis 

to a Marker (Key Event) of their choice, if there are any saved for the associated video and 

digitisation trace. The x axis will then be frame numbers relative to that frame.  

Relative Time (Marker) - This allows the user to change the 0 point of the x axis to a 

Marker (Key Event) of their choice, if there are any saved for the associated video and 

digitisation trace. The x axis will then be time relative to that frame.  

 



 

 

Vertical Axes – This will allow the user to adjust the Vertical Axes of the Displacement, 

Velocity and Acceleration graphs independently. As default, Quintic will automatically scale 

the Vertical Axes to the best possible fit, so that both the minimum and maximum values 

are displayed in each graph.  

 

 

 

 

 

 

Users are able to manually adjust the Vertical Axes, by unticking the ‘Automatically Scale 

Vertical Axis’ for the graph they would like to manually scale, whether this be Distance, 

Velocity or Acceleration. Then simply enter in the Minimum and Maximum values you 

would like the vertical axis to display. You should notice the graph being updated live. 

Once you have set the vertical axis, simply close the Vertical Axes Settings Window. These 

axes settings will be remembered when opening and closing the analysis window.  

Raw/Smoothed – This allows the user to display either the Raw data for the distance, 

velocity and acceleration graphs or the Smoothed data with the parameters selected from  

within the smoothing window.  

Moving Average – As default, a moving average is applied to the digitised data. This will 

be a moving average of 5 i.e the average of 2 frames previous to your current frame, your 

current frame and 2 frames after your current frame. This applies to all of the distance, 

velocity and acceleration graphs. The user is able to control how many frames should be 

taken into account for the moving average (3, 5, 7, 9, 11) or turn the moving average off 

completely (1).  

Linear Spline – As default, a Linear spline is applied to the digitised data, in order for it to 

appear smoother. The user has the ability to turn this linear spline on or off by either 

selecting or deselecting this option within the analysis window.  



 

 

Velocity and Acceleration – This allows the user to edit the way velocity and acceleration 

is calculated and displayed. This can either be: 

• one frame before 

• one frame before and one after  

Show First/Last 6 Frames – This controls whether the first 6 and last 6 digitised frames 

are displayed within the analysis windows. As default, Quintic will not display these frames 

due to any potential smoothing filters applied to the data. The user is able to control 

whether this should be on or off. 

 

f. Origin  

Within the Origin Menu, the user is able to change the origin of the data. The origin options 

are either: Relative (from the start point of the marker) or Absolute (the 0,0 coordinate). If a 

user has a Custom Origin, the Absolute option will be ‘Absolute (Custom)’, if there is no 

Custom Origin, the Absolute option will be ‘Absolute (Standard)’. As default the Quintic 

analysis windows will be set to relative.  

  

 

 

g. Save Excel  

Within the Save Excel menu, the user is able to save the results which are displayed on the 

Distance, Velocity and Acceleration graphs into an Excel spreadsheet for further analysis.  

 

 

 

 



 

 

Users have the option to: 

Save Results – Saves whatever points are displayed on the distance, velocity and 

acceleration graphs.  

Save Results (Co-Ordinates Only) – Saves the co-ordinates of each point only. The user is 

then able to calculate the distance, velocity and acceleration manually.  

Save Min/Max – Saves the Min/Max of the points displayed on the graphs. X position is 

also given (whether this be frame number or time).  

With any option, users can either save the excel as an .xls (97-2003) or an .xlsx (2007 +). It 

is recommended that .xls is used for clients who are using the excels for our Quintic 

Automatic Reporting Software. Once you have chosen your preferred file type, simply 

choose where you would like the file to be saved and name it appropriately.  

h. Settings 

Within the Settings menu, the user is able to choose their preferred settings for ‘Save 

Results – Points’, ‘Use Focus Region (Saving/Min/Max), ‘Save Results – Frame Markers 

ONLY’ or ‘Single Linear Analysis Defaults’.  

 

 

 

Save Results – Points - When exporting the data from the Single Linear Analysis Window, 

users are able to choose which data is exported to the Excel.  

Users can ‘Save All Points’ or ‘Save Selected Points’ within the ‘Save Results – Points’ 

setting in the Single Linear Analysis Window. For example, if you have only selected the 

Knee point and chosen the ‘Save Selected Points’ option, only the knee data will be 

exported to the Excel.  

 

 

 



 

 

Use Focus Region (Saving/Min/Max) - Users can also choose to save all the data on the 

graph or a particular region of the graph. They are able to do this by going to Settings, then 

‘Use Focus Region (Saving/Min/Max)’. 

 

 

 

 

When the ‘Use Focus Region (Saving/Min/Max)’ is activated, the focus region will show on 

the graphs in Gold vertical lines.  

Users can control the save region by using the ‘Focus Region’ sliders on the right-hand side 

of the Single Linear Analysis Window.  

 

 

 

To use the particular region you have selected, click ‘Use Focus Region’ and when you save 

results as an Excel (by going to the Save Results tab), only the points within the saved region 

will be saved to the Excel. This is ideal for clients who own and use any of the Quintic 

Automatic Reports. 

The Focus Region also effects the Min and Maxs. If the focus region is in use, and Min/Max 

are also in use, only the Min/Max within the Focus Region will be displayed on the graphs.  



 

 

Save Results – Frame Markers ONLY – This allows the user to export the data from the 

Frame Event Markers to Excel. Please note that the video must have Frame Markers set. 

Single Linear Analysis Defaults – This gives the user the option to set their default analysis 

window settings (Single Linear only for Sports v35). Every time you open the Single Linear 

Analysis window, your preferred analysis settings will be remembered and used. 

 

 

 



 

 

Once you are happy with the settings that you have chosen, go to the settings option within 

the analysis window.  

Then select ‘Set Current Choices As Defaults’ and this will remember your preferred settings.  

 

 

An information window will pop up to confirm that the defaults have been set.  

 

 

 

 

In order for the software to load your default analysis settings, please select ‘Load Analysis 

Using Defaults’ for the Single Linear Analysis window. You would have to do this for each of 

the analysis windows (Single Linear, Single Angular, Multi Linear and Multi Angular).  

 

 

 

 

Please see below for more information on what will be remembered in the Single Linear 

Analysis Window: 

Single Linear 

• Template Point Names (to check that when Single Linear is next loaded, it is the 
correct template) 

• Which points within the template are selected (so if it’s a side view gait you might have 
hip and knee ticked and all the others unticked – this will mean it is just hip and knee 
are displayed when you next open a side view gait) 

• Linear/Horizontal/Vertical choice (inc. Horizontal Opp.) 

• Whether you have expanded a graph 

• Which your preferred Unit is in the Units drop-down 

• Your display preferences (specifically: Show Interpolation Markers, Show Frame 
Position, Show Frame Markers, Show Interpolated Regions) 

• Min/Max display choices 

• Origin drop-down choice 
 



 

 

3. Single Video Angular Analysis 

Once the video has been digitised and the trace has been loaded, simply click on the 

‘Single Video Angular Analysis’ option after the Angular Analysis button has been 

pressed.  

If the digitisation trace has not been loaded on the video, the following pop up will appear, 

asking you to load the digitisation trace. Please click ‘Yes’.  

 

 

 

 

 

Once the digitisation trace is loaded and the ‘Single Video Angular Analysis’ button has 

been pressed, the Single Video Angular analysis window will load.  

This will display the Angular Displacement, Angular Velocity and Angular Acceleration in 3 

different graphs, for the selected angle throughout the digitisation trace. As default, the 

angle that is calculated is the first three points, e.g Vertical, Point 1 and Point 2.   

If there are any Time Event Markers (please see Tutorial 2 for further information) that 

have been saved with the current video, they will also be displayed onto all 3 graphs. This 

will allow the user to quickly identify on the graph the key events of interest to them (e.g. 

Impact, Low Point, Toe Off etc). The Time Event Markers will be displayed on the graphs 

by a blue line, with the default name of Marker 1, Marker 2, if the Time Event Markers have 

not been named, or the relevant name of that marker if they have been named.  

Any Interpolation Markers that have been added to the digitisation trace and saved, will 

also be shown on the graphs. These are shown with a burgundy line on the graphs.  

Please see below an example of the Single Video Angular Analysis Window within Quintic 

Biomechanics v35 software.  



 

 

 

 

Both the video and analysis windows are synchronised, therefore if the video is played 

while the separate analysis window is open, a black line indicates the current video frame. 

 



 

 

 

 

 

 

 

 

Live Data Table – This button will open the Live Data table, 

which allows the user to easily identify data values at 

specific points of interest, throughout the video. Please see 

the heading Live Data Table below for more information.  

 
This is where the user is able to create the angle they wish 

to analyse. The digitisation template will be displayed along 

with the vertical and horizontal. To create an angle, the user 

simply chooses the three points in which the angle is 

created, with Point B being the centre of the angle you are 

interested in and Point A and C the points from which the 

angle is created. For example, to create the ankle angle, 

Knee would be point A, Ankle point B and Toe point C.  

 

This allows the user to ‘Opposite’, ‘Flip’, ‘Flip AB Line’ or 

‘Flip BC Line’ for the angle being displayed. Opposite will 

display the opposite angle from the one currently being 

displayed (i.e 360 minus). Flip will change the angle from 

positive to negative or vice versa. Flip AB Line will flip the 

AB Line of the created angle. Flip BC Line will flip the BC 

Line of the created angle.  

 
This displays information on the data series. Please see 

above under Single Linear Analysis for further information 

on each heading.  

 
These buttons will either reset the current angle you are 

displaying or all of the angles you have created on the 

graphs.  

 
This counter allows the user to display more than one angle 

on the graph. When increased the user then is able to 

create another angle to display. The user is able to display 

up to 10 angles on the same graph. The counter can also be 

used to toggle between which angles are displayed on the 

relevant pie charts. 

 

This provides an overview of the current angle being 

displayed on the graph. It informs the user on the points 

from which the angle is created. As well as this, the live 

angle is shown in a text and pie chart format, which gets 

updated frame by frame as the video is scrolled/played. The 

opposite is also displayed in black with the live angle being 

displayed in blue. The user also has the option to display the 

live angle from pie chart 1 (only the angle relating to Pie 

Chart 1 can be used) on the video footage. Once you have 

selected your angle, simply tick the ‘Show on Video’ box 

next to Pie Chart 1. This will then show the angle in question 

on the video. 

  



 

 

a. Functions 

Within the Single Video Angular Analysis window there are a range of functions which the 

user is able to change, which directly affects the Angular displacement, velocity and 

acceleration graphs.  

The functions are available at the top of the Single Video Angular Analysis Window and are 

as follows: 

 

b. File  

Within the File menu, the user is able to Print, Print Preview, Save as JPEG or Copy to 

Clipboard the individual Angular Displacement, Velocity and Acceleration graphs. The user 

is also able to Print, Save as JPEG or Copy to Clipboard the Angular Displacement, 

Velocity and Acceleration Graphs with or without the side bar as one image.  

 

 

 

 

c. Units 

Within the Units menu, the user is able to change the units for the data within the Angular 

Displacement, Velocity and Acceleration Graphs. The options are as follows: Degrees, 

Radians.  

 

 

 

 



 

 

d. Frames/Page 

Within the Frames/Page menu, the user is able to select how many frames are displayed 

on the graphs within the analysis window. This is ideal for users who have long digitisation 

traces. 

 

 

 

 

 

As default, the analysis windows will display all of the points on the graphs. Should users 

want to change this, they are able to do this by going to the Help tab within the main 

Quintic software. To do this, click the ‘Help’ button, then Settings, Analysis Defaults, 

Frames/Page and then select your preferred option. This will apply to all analysis windows. 

 

 

 

 

 

 

  

 

 

 

 



 

 

e. Display 

Within the Display menu, the user is able to able to adjust certain display settings which 

affect the Angular Displacement, Velocity and Acceleration graphs.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

These have already been covered. 

Please see above under ‘Single 

Linear Analysis’ for more 

information on these features. 

 



 

 

Opposite Angles – Opposite will display the opposite angle from the one currently being 

displayed. 

Flip Angle Sign – This will change the angle from positive to negative or vice versa. 

Negative Angles – This allows negative angles to be displayed. As default, this setting is 

switched on. This is particularly useful when looking at an angle which fluctuates around 0.  

Horizontal – If an angle has been created using the horizontal, the user is able to choose 

whether the horizontal will be to the left or to the right. As Default this is set to the right.  

Vertical – If an angle has been created using the vertical, the user is able to choose 

whether the vertical will be to the top or bottom. As default this is set to the top.  

Lock Pie Chart Horizontal – This will allow the user to lock the pie chart to the horizontal.  

Lock Pie Chart Vertical – This will allow the user to lock the pie chart to the vertical.  

Number of Pie Charts – The user is able to control how many pie charts are displayed 

next to the graphs within Single Angular Analysis (maximum of 3). Users are able to use 

the top counter within the Single Angular Analysis to create more than one angle on the 

graph. You can then use the other counters to show the angles of interest on the 3 Pie 

Charts. 

 

 

 

 

 

 

 

 

 



 

 

f. Save Excel  

Within the Save Excel menu, the user is able to save the results which are displayed on the 

Angular Displacement, Velocity and Acceleration graphs into an Excel spreadsheet for 

further analysis.  

 

 

Users have the option to: 

Save Results – Saves whatever angles (up to 10) are displayed on the angular 

displacement, velocity and acceleration graphs.  

Save Results (Angles Only) – Saves the angles only. The user is then able to calculate the 

angular velocity and acceleration manually.  

Save Min/Max - Saves the Min/Max of the angles displayed on the graphs. X position is 

also given (whether this be frame number or time). 

With any option, users can either save the excel as an .xls (97-2003) or an .xlsx (2007 +). 

Once you have chosen your preferred file type, simply choose where you would like the file 

to be saved and name it appropriately. 

g. Settings 

Within the Settings menu, the user is able to choose their preferred settings for ‘Use Focus 

Region (Saving/Min/Max)’, ‘Save Result – Frame Markers ONLY’ or ‘Single Angular 

Analysis Defaults’. 

 

 

Use Focus Region (Saving/Min/Max) – Users can choose to save all the data on the graph 

or a particular region of the graph. They are able to do this by going to Settings, then ‘Use 

Focus Region (Saving/Min/Max)’. 

 

 



 

 

When the ‘Use Focus Region (Saving/Min/Max)’ is activated, the save region will show on 

the graphs in Gold vertical lines.  

 

 

 

 

Users can control the save region by using the ‘Focus Region’ sliders on the right-hand 

side of the Single Angular Analysis Window.  

 

 

 

To use the particular region you have selected, click ‘Use Focus Region’ and when you 

save results as an Excel (by going to the Save Results tab), only the points within the 

saved region will be saved to the Excel.  

The Focus Region also effects the Min and Maxs. If the focus region is in use, and 

Min/Max are also in use, only the Min/Max within the Focus Region will be displayed on the 

graphs.  

Save Results – Frame Markers ONLY – This allows the user to export the data from the 

Frame Event Markers to Excel. Please note that the video must have Frame Markers set. 

Single Angular Analysis Defaults – This gives the user the option to set their default 

analysis window settings. Every time you open the Single Angular Analysis window, your 

preferred analysis settings will be remembered and used. 

Once you are happy with the settings that you have chosen, go to the settings option within 

the analysis window. Then select ‘Single Angular Analysis Defaults’ then ‘Set Current 

Choices As Defaults’ and this will remember your preferred settings. 

 



 

 

 

 

 

An information window will pop up to confirm that the defaults have been set.  

 

 

 

 

In order for the software to load your default analysis settings, please select ‘Load Analysis 

Using Defaults’ for the Single Angular Analysis Window. You would have to do this for each of 

the analysis windows (Single Linear, Single Angular, Multi Linear and Multi Angular).  

 

 

 

 

Please see below for more information on what will be remembered in the Single Angular 

Analysis window: 

Single Angular 

• Template Point Names (to check that when Single Angular is next loaded, it is the 
correct template) 

• Selection of up to 10 angles and whether they were “opposited,” “flipped,” or had “lines 
flipped” 

• Chosen angle to be displayed across all 3 pie charts 

• Whether you have expanded a graph 

• Which your preferred Unit is in the Units drop-down 

• Your display preferences (specifically: Show Series Values, Show Interpolation 
Markers, Show Frame Position, Show Frame Markers, Show Interpolated Regions) 

• Min/Max display choices 

• Allow Negative Angles choice 

• Horizontal – Left/Right choice 

• Vertical – Up/Down choice 

• Pie Chart – Lock Horizontal/Vertical choice 

• Number of pie charts displayed 
 



 

 

4) Live Data Table 

Within the Linear and Angular analysis windows, there is an option to display the live data 

table.  

 

To display the Live Data Table, simply click the Live Data button within the Linear or 

Angular analysis window.  

 

This will then display the data which is displayed on the Distance, Velocity and 

Acceleration graphs.  

As the video plays through, the Live Data table will be updated with the current frame data.  

Within the Analysis windows, if any points of the digitisation trace are unticked, this data 

will not be displayed within the Live Data table. If the Horizontal and Vertical (Linear 

Analysis only) options are ticked on the graph, this will also be displayed on the Live Data 

Table.  

 

 


